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Thank you for your purchase. Now you can put the power of digital pen technology to work.
Capturx for ArcGIS Desktop is a powerful, easy-to-use, digital data collection solution that
enables you to keep using paper maps. Our extension is the ideal way to create, import,
edit, share, and act on paper-based data in and between geographic information systems
(GIS).

With Capturx for ArcGIS Desktop and Pen Manager and Capturx Mobile software you will be
able to:

e Print maps with various feature layers on ordinary paper. You can select a feature
from the printed legend and then draw it on the map. When the digital pen docks
with the PC, the data, including the classification of those features, automatically
gets updated within the geodatabase.

¢ Use the Pen Manager for Windows, Capturx Mobile, Windows Mobile, and other
handsets to manage and upload your data. The Pen Manager enables you to
manage the features and options available on your pen and to send the file
containing the ink via email

This guide describes the process for using Capturx for ArcGIS Desktop and Pen Manager
software and to provide a comprehensive explanation of their features.

The topics and information in this user manual include:

e How to charge and use your pen

e Registering and activating your software and pen

e Using the Pen Managers

e Capturx for ArcGIS overview

e Using the Capturx for ArcGIS toolbar and buttons

¢ Opening a map and selecting a legend

e Printing your map and legend

e How to use Capturx for ArcGIS Desktop to create data
e Uploading data from the pen to ArcMap

e Troubleshooting and maintenance

These sections and topics will help you learn to use Capturx for ArcGIS Desktop.



The pen looks and feels just like an ordinary ballpoint pen and you use it in the same way.
There are no keys to press. You activate the pen simply by removing the cap and deactivate
it by replacing the cap. The pen needs to be charged before you can use it to capture data.

To charge the pen:

1. You may need to place the ink cartridge in the pen. To place the cartridge in the pen,

take one of the ink cartridges and gently slide it into the hole at the tip until it is

completely seated and does not fall out.

Attach the docking station to a PC or laptop via the USB port.

Fully insert the pen in the docking station.

4. The gold connection points on the pen and docking station need to be aligned and
the pen needs to be firmly placed in the docking station.

5. After you connect the USB port to your computer and dock your pen, you will initially
need to keep the pen in the docking station for four hours for it to fully charge.
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Note: To prevent your battery from running low, do not leave the cap off the pen for
extended periods of time. You will heed your pen cap so keep it in a place you will
remember.

For information on how to use the pen and docking station to upload data, see Using the
Pen and Docking Station.

After installing Capturx for ArcGIS Desktop, you will be prompted to complete the following
steps for registering your software and activating your digital pen(s). The steps include:

e Registering your software

e Activating the pen

e Registering the digital pen(s)

e Importing the digital pattern for printing from your digital pen

e Moving digital pattern from previous versions of Capturx software to the current
version of Capturx for ArcGIS Desktop

Registering and Activating Your Software

You register and activate your Capturx software by filling out a registration form and you
activate the software by docking the pen. When you first open Capturx for ArcGIS Desktop,
you will see the following activation screen:


../My%20RoboHelp%20Projects/Capturx%20for%20ArcGIS/Head/Documentation/Capturx%20for%20ArcGIS/!SSL!/WebHelp/Using_the_Pen_and_Docking_Station.htm
../My%20RoboHelp%20Projects/Capturx%20for%20ArcGIS/Head/Documentation/Capturx%20for%20ArcGIS/!SSL!/WebHelp/Using_the_Pen_and_Docking_Station.htm

To begin using Capturx you will need to activate the digital
pen included with Capturx and register your software to
receive important benefits.

In the following screens you will be prompted to:

* Register your software with Adapx

Complete Adtivation by Docking a Pen

The green arrow shows you the step you are on in the activation process. To register your
software with Adapx, select the Next button. This will open the Register Software form.

” H 9
(il Register Software ==

MName:

Email:

Phone Mumber (optional):

Company:
Walid registration information is required for customers to
receive important maintenance and support. f you are unable

to submit the registration online you can save the information
and email the registration file to sales@adapx.com

| hawve read and agres to the terms of the Adapx Privacy Policy.
[ . _
Adapx Privacy Policy

[ Remind Me Later

To complete the registration process:
1. Fill in the form with the required information.
2. Select the Save Button to save your registration information. Select the Remind Me
Later button if you want to complete the form later.

To complete the software activation, dock the pen and select the Next button.



Complete Activation by Docking a Pen

Registering and Activating Your Pen

The first time a pen is docked, you will see the Capturx Pen Startup Wizard. The green
arrow shows you the step you are on in the activation process. The check mark denotes the
parts of the process that have been completed and the warning sign denotes a procedure

that failed.

Ll Capturx Pen Startup Wizard

Thank. ywou for purchazing Capturx,

To begin you will need to activate ywour digital peniz) by
connecting the pen to your po, installing digital pattern to your
pc and registering your digital pen by following the steps below,

» Activate your pen Use Offline Key

._-/ Regizter your pen with Adap:x
,_./ Import Cigital Pattern

Migrate Digital Pattern from prewious Capturx wersions

¥ Prompt Later Cancel hotivate

All new pens shipped with Capturx for ArcGIS have been activated. If you are using a pen
that was purchased with different software, you many need to manually activate. The
manual activation enables the digital pattern for use.

Select the Use Offline Key button.

2. The Manual Pen Activation window will appear. Enter the key you received from
Adapx sales.

3. Enter the key and select the OK button.
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To register your pen:

1. Select the Activate button to open the

registration form.

v Prompt Later Cancel

| Activate |

Email:
Phone Number (optional):

Company:

—  Adapx Privacy Policy

[ Remind Me Later

= This information will be protected under the terms of the

2. Fill in the form with the required information.

3. Select the Save Button to save your registration information. Their registration
details are saved to file, so you can print the registration information and fax it or
mail it to Adapx. Select the Remind Me Later button if you want to complete the

form later.

If your connection uses a proxy server, you may have to enter proxy information to

complete the activation.

To provide the proxy information:

1. The Adapx Proxy Settings window will appear when you select Activate



[J Adapx Prowy Settings

F=Rch ==

Flease enter your web prooy infomation.

¥ | Use the following proxy settings

Proogy Settngs
This prosy uses a Secune protocol

Address

proncy Ry Company com|

Resull:  hitp//proxy mycompany.com: 20280
FBemember these settings

Post
2080

[ ok || Canca

2. Check the Use the Following proxy setting check box and enter the proxy
address for your company and select the OK button. Ask your systems administrator

if your proxy uses a secure protocol.

3. Depending on how your systems administrator, selecting OK may require
authentication. If so the following dialog will appear:

F

[d Adapx Proxy Authentication

The prowy server:
www adapx.com
reguires a user name and password.

Lser Name:

(o] & =

Password:

Ok

J I Cancel

4. Enter your User Name and Password and select the OK button

To migrate digital pattern from previous versions of Capturx software:

1. Select the Migrate button.



P Capturx Pen Startup Wizard [ZI

Thank you for purchasing Capturx.

To begin you will need to activate your digital pen(s) by
connecting the pen to your pc, installing digital pattern to your
pc and registering your digital pen by following the steps below,

f_/ Activate your pen
t/ Register your pen with Adapx
o Import Digital Pattern

f/' Migrate Digital Pattern from previous Capturx versions

¥ Prompt Later Cancel . Migrate —

2. The Migrate Digital Pattern window will appear. Using the Size and Count table

provided as a guideline, select the percentage of pages to move and select the Move
button.

o e =T
Lad Migrate Digital Patte [

A pool of digital pattern from a previous version of Capturx
Forms for Excel or Capturx for Autodesk Design Review has been
found on this machine. Please select the quantity of pattern you
would like to move from this pool to the current account. Note
that any pattern you move wil not be available for use by the
previous versions.

| Count Percent of Pages to Move

=




When you have completed the procedures for registering and activating your pen, select the
Complete button at the bottom of the wizard.

Activate your pen for Capturx use
Register your pen with Adapx

# #‘"r Import Digital Pattern

Migrate Digital Pattern from previous Captur< versions

Back | Skip

Cancel | Complete

Capturx for ArcGIS provides you with access to two Pen Managers (Windows and Capturx
Mobile for BlackBerry) that can be used to send your ink to an email address or to a Capturx
server. In addition, the Pen Manager for Windows also enables you to manage the features
and options available on your pen. Listed below is an overview of these Pen Managers, their
features, and links to their user guides.

Capturx Pen Manager

The Pen Manager is installed on your computer when you install Capturx for ArcGIS. This
Pen Manager allows you to manage the ink you upload when you dock your pen. Using this
Pen Manager you can:

e Send the file containing the ink via email or to the Capturx server
¢ View the remaining time left on the battery of the pen

e Download and delete the pages currently on the pen

e Set how you want the pages to download

e Enter and save personal details to the pen

e Enable or disable the Bluetooth feature on the pen

For more information on Pen Manager for Windows and its features, see the user guide:

http://www.adapx.com/capturxpenmanager/Capturx Pen Manager UserGuide 2.6.pdf

Capturx Mobile for BlackBerry

The Capturx Mobile for BlackBerry allows you to use your mobile device to send your pen
data. This allows you to:

e Bluetooth pair your pen to your mobile device
e Use your BlackBerry to send the file containing the ink via email
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http://www.adapx.com/capturxpenmanager/Capturx_Pen_Manager_UserGuide_2.6.pdf

e Use GPS mode to set and view location information about your uploaded file
e See a log of recent activity with a date and time stamp
e Easily email Adapx product and technical support
For more information on Capturx Mobile for BlackBerry and its features, see the user guide:

http://www.adapx.com/WebHelp/CapturxPenManagerForBlackBerry/Help/1.0/Index.htm

The following process flow shows you the overall process used to capture, review, and edit
digital pen data. This includes the steps involved in:

e Preparing and printing your map and legend

e Using the pen to create ArcGIS data

e Docking the pen and transmitting the features you have created

e Reviewing and editing your changes using the Capturx ArcGIS Desktop extension

Capturx for ArcGIS Desktop Process

Add the Default

Installing the Opening the Map Creating and

Software and lI'IS-;-;LI::iLDUT &  fouWantto [ Rﬁxre:::;::p Pacing Your
Creating Your Map Update Legend to the Map Legend

% "

Use Pen with the Redline/
Markup Layer and/or Legend
kcons o Create Features on
the Map

Using the Pen and -
Digital Map

Printing the Map
and Legend

Upload Changes

Docking the Pen and
Uploading Data

Reviewing Yaur
Changes

Attaching the
Docking Station to |
PC ar Laptop via
USB Port

Locally or to a
—— Designated Email
Address, ar Maobile
Device

e ——————

—

. g Uploaded or File is

Features are

Sent

Using the Toolbar
to Review and
Accept or Reject
the Changes You
Made
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http://www.adapx.com/WebHelp/CapturxPenManagerForBlackBerry/Help/1.0/Index.htm

At the most general level, the Capturx for ArcGIS extension toolbar is used to:

e Add a Redline/Markup layer to your map

e Print the page layout containing the map and legend you have selected

e Use the import options to import the ink strokes you have made on your map so
they can be reviewed and accepted or rejected

e Use the review options for selecting the ink strokes you have made and accepting or
rejecting these changes

The States of the Toolbar and Buttons

The toolbar consists of 12 buttons and some of these buttons will be disabled (grayed out)
depending on where you are in the process of capturing and reviewing your field data and
whether you are in layout or data view. As shown below, the toolbar can be in different
general states with different options disabled:

Toolbar How it is Used
Button

— Add Redline/Markup Layer: This button is used to add an Redline/Markup
3/ layer that you can use to write notes on your map. This takes you to a dialog
box that enables you to:

e Select the data frame you want to apply the layer to
e Provide a name for the layer
e Select the path to the location where you want to store the files.

Note: The layer will have the same coordinate system as the data frame.

Print Page Layout: This button is used to print the page layout. This takes you
[EI] to the print dialog.

+* Import Next Session for Current Map: This button is used download the
current session for the map you are working on so that your changes will appear
on the map. This button is only active if there are sessions waiting for the
currently loaded map.

Open the Session Dialog Box: This button will show you a current list of
QJ sessions you have uploaded using your pen so you can choose a session from
the list. This dialog includes the:

¢ Name of the map
e User name associated with the pen
e The time and date the upload was received

You can also use this dialog box to delete a session. Sessions that correspond
with other maps will be inactive.
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Select All Capturx Features: This button is used to select all of the features
(except Redline/Markup strokes) you have made on your map.

&

Clear All Selected Features: This button is used to deselect any of the
features you have made on your map

&

Select the First Change: This button is used to select the first feature you
have made on your map

feature you have made on your map

Select the Next Change: As you move through the changes you have made,

d Select the Previous Change: This button is used to select the previous
6 this button is used to select the next feature you have made on your map.

Select the Last Change: This button is used to select the last feature you
:ﬂl have made on your map.

Reject All Changes: This button is used to reject all of the feature you have
./ made on your map

Accept All Changes: This button is used to accept all of the features you have

% made on your map.

A legend, when printed with Capturx for ArcGIS, becomes a digital palette for creating
features. This section describes the process for opening a map and creating and placing the
legend you will use to add features to your map. This includes:

e How to open the map you want to use with Capturx for ArcGIS Desktop
¢ How to use the ArcMap Legend Wizard to select the layers you want to include in
your legend.

To create a map and legend:

1. Open ArcMap.
2. Select the map you want to use.
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Ed

. ArcMap
Start uzing Archap with

g " & pew smphy map

™ & lemplate

Templates provide ieady-to-use lapouts and base maps for
Vamaug qeographic 1egions,

R

™ Immedisiely acd data

[~ D rict shave this cisleg agsin

I Load last map on starhup

3. Once you have a map with data layers added, From the View Menu, select Layout

View.

Wiew Bookmarks Insert Selection

@ Data view
—_— @ Layouk Yiew

Zoom Data ]

Zoom Layouk »

4. From the Insert Menu, select Legend.
5. Use the Legend Wizard to select the layers you want to include in your Legend.
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Legend Wizard El

Choose whach |apers wou want o include in you legend

M ap Lapers: Legend [tems
| CapuncMako I
Stagimg_Font j s J
Command_Location
it |
Fi
F::_Truck |
Poilce_Vehicle
Difscer_Down i]
Preipetraton_location
Perpetraton_Vehicle ;I
Citizen_Diown "
<« e » £

Set the number of columns in yow legend: |1 :I;I

Preneaw

Mesdt Cancel |

o

Select Next in each dialog box after closing the style sessions.

Select Finish on last dialog

8. The items you have selected will appear in the legend. Note: You can also right-click
on the legend once it has been added to your layout and choose Properties to
modify it later.

9. Use your mouse to drag it to the desired location on the map and to re-size it.

N

Selecting Pattern to Meet Your Needs

When you print with Capturx, a digital dot pattern (sometimes called a digital watermark) is
printed on the paper along with your map layout. Before you print, you need to know how
this pattern is used when you print your map and how to select the pattern size that best
meets your needs. This section describes:

¢ How the pattern is used to print your digital map

e How to use the Printing dialog box to learn how much pattern you have available and
how to get more pattern when you are running low

How the Pattern is Used to Print Your Digital Map

Digital pattern is required to print the digital map you will use. Pattern is available in 3 sizes
(A0, A2, and A4), and each size has an exact number of pages available for printing. These
pages are referred to as a "shelf" of pattern.
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Size mm x mm in % in Approx. US equivalent No. of sheets/Refill
Ad 210 »« 297 B.3x 1.7 letter: 8-1/2" x 11" 6,144 sheets
A2 420 = 594 165 = 234 tabloid: 11" x 17" 3,872 sheets
A0 841x 1189 331x468  E-size or large plotter 1,952 sheets
What you plan to print Option to
choose

I will ONLY print LETTER size maps (8-1/2" x 11") Select A4
from this computer

I will print LETTER (8-1/2" x 11") and TABLOID Select A2
(11" x 17") size maps

I will connect this PC to a PLOTTER (you will still be Select AO
able to print smaller sizes)

A larger size pattern can be used to print a smaller size page layout. For example, one-
square-yard “AQ” can be used to print a letter-size 8.5” x 11" page layout. However, there
are fewer pages in a refill of a larger size pattern, so it is more cost efficient to use the
smallest size pattern you can. If you have more than one shelf of pattern, Capturx will
automatically choose the smallest sized pattern possible in order to conserve pattern pages.

If you have downloaded pattern that is too large for the size you would like to print ("A0”
being used to print a letter-size 8.5” x 11” page layout) you can still print, but you will see a
warning notice in red text at the lower left of the print dialog noting that you could use
smaller pattern. If you do not have a additional pattern credit available, you can purchase
one by contacting sales@adapx.com.

Monitoring and Using Pattern in ArcGIS Desktop
Capturx for ArcGIS provides you with a Pattern Refill dialog box and a Desktop printing
dialog that you use to download pattern and to monitor the amount of pattern you have

Adapx Capturx Pattern Refill r;l - @ Capturx for ArcGIS Desktop Printing r.—l =]

Beloe pinting. you should dowrload some pattern in the 2i2e you want Copies Patiem Curerty Avalstie
P. Status Belore Refill Ses !

attern Status e Pattern Szes to Refll N y [ﬁ

— " . Coprot

Al EMPTY I ADSize Paper upto 458" x 468")

A2 EMPTY I~ A2Size Paper fupto 234"« 234") Got Moce Pation I

Ad EMPTY ™ Ad/Letter Sics Papet {up to 14.0" x 14.07 Pricker

Name inodalHP Color Latertet 5500

To purchase mote patten refills, you nay vt Status Idgie

bitp: /e N | _ Concel | Tipe WP Color LasesJet 5500 FCL 6
Wheie Seotile HQ Dffices

Commert.  Color, Duplex, Large Format

Deskto %
pattem Reﬁll Printing — Note: To change pantes, use File menu, Page and Pinier Satings
Dialog Box Dialog Box —
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When you're in the Pattern Refill dialog, you have the option to download any size pattern
that you don't already have more than 1000 pages of. If you already have more than 1000
pattern pages, the checkbox for that size will be grayed out.

The bars on the pattern control are full/green at 1000 pattern pages or more. If there is less
than 800 pages left you can find out exactly how many pages you have by hovering on that

bar, otherwise the hover text just reads ‘full’

Capturx for ArcGIS Desktop Printing 0| x}

Copees ~ 1 | Pattesn Cuntently Avadable
'é“"""'d [ = ::xo: nﬁwml
I~ Puntto File :
Get More Pattern ”

Printes

Name: UNODAL\Seattle OKI C6100(PS)
Status Other

Type: OKI CS100(PS)

Whetee  Seattle HQ Offices

Comment  Color Map Prnter

Note: To change printer, use File menu, Page and Prrder Settings

[ox_]_coxe |

Capturx for ArcilS Desktop Printing

w mwrh

| (A2 ful
caMaerorer || N

Note: To change printer, use Fie menu. Page and Printer Setting:

Printer

Name. UWNODAL\Seattle OKI C8100(PS)
Statuz: Other

Type: OKI C5100(PS)

Where:  Seattle HQ Offices

Comment.  Color Map Printer

] raso]

Printing the Page Layout and Legend

The following section describes the process for printing the page layout and legend. This

includes:

e The steps for printing the page layout and legend

e A description of the map "Layout View"

To print the page layout and legend:

1. Within ArcMap, select printer options by selecting File>Page and Print Setup.
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Fle Edt Yiew [nsert Jelection Jools Window Hel
D yew... Ctri+N
& sove kS
Save &s...
Save A Copy...
Select Print
and Page & AddDags...
Setup —— | |

2. This will open the Page and Print Setup window. When using this window:

e Set your printer to use the size of paper desired as the “default tray”, since
the “source” (paper tray) setting in this Page and Print Setup window is not
currently supported

e The “Scale Map Elements proportionally to changes in Page Size” option is

helpful to keep your page elements (map, legend) within the area of the page

that will actually be printed.
o Select the Use Printer Paper Settings radio button
e The image in the lower right corner of the dialog will show a visual

representation of how your map will fit on the paper size and orientation you
choose. If the image falls outside the page margin, you will need to choose a

different setting.
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Page and Print Setup i l‘ﬁl

Map Page Size

; [T Use Printer Paper Settings

| Page
Standard Sizes: | Custom =]
Widthe 11 [inches ¥
Height {85 | Inches =~
Onentation: " Portrat (¢ Landscape

[~ Printer Setup 1
Nase: |22 \\Noda\HP Color LasesJet 5500 ~]  Properbes... |
Status: Ready
Type: HP Color LasesJet 5500 PCL 6
Whese: IP_192 168 190.254
Comments:  Color, Duplex, Latge Format

Papes

Sie: [Lettes > | ) Printer Paper

Source: | Automatically Select B [ | Pinter Margns
Orentation: C Potiat " Landecape [:] Map Page [Page Layout)

@ Sample Map Elements

R
Vs
"u L B

[~ v Pre teane o Layor [ Scale Map Elements proportionally to changes in Page Size

.

3. You need to be in the Layout View to print your map. Select View>Layout View to

print your map.

View [nsert Selection Took Wind

Select Lavout @ Data View
View ——» Q Layout Yiew

Zoom Data »

This will display the map in “Layout View”. This view provides rulers and printer margins

that will help you see the actual orientation of your page layout (portrait or landscape) and

determine how the page is printed.

By showing you the size of the page layout these rulers also show you what size paper you

should be setting your printer to use (make sure that the printer’s “default tray” is using
paper of that size.) As noted above, you must set the default printer tray to the size you

like before printing or loading the appropriate size paper you are using into the default tray.
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As noted below, in the Page Layout, you might want to keep anything you want to write on,
such as a map frame or a legend icon, at least 7 mm away from the printer margins.

1. Select the Print button on the Capturx toolbar to print current layout.

| @

Note: If the legend has layers that are from data sources that we cannot modify, or that are
not fully compatible, a “"Layer Support Information” form will pop up before printing. This
form lists the unsupported layers and unsupported symbology. If you see this form, you can
cancel printing, or continue on to print.

o

Even though these layers are not supported, you will still be able to print and markup the
map. New features will not be created on these unsupported layers but all markups will be
added to the Redline/Markup layer.
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How to Use the Pen to Create Features

The following section describes how the pen and legend are used to add features on your
map so you can update the desired layer with new information. This includes an overview of
the two distinct functional states used by Capturx for ArcGIS to create data.

Digital Pen Functional States
To allow you to easily add new information to your map, the digital pen used with Capturx
for ArcGIS provides two functional states to create markups

e The Redline/Markup state is turned on by default and the line color can be changed
by touching the legend item in the Capturx Markup layer

e The Feature Creation state is enabled by touching any feature symbol on the legend
of the printed map

The following sections illustrate the two functional states and how these are used to add
features to the map. The following figure shows the layers for these options and how they
are shown on the map legend.

Legend in Layout View

Legend

Capturx Markup
Redline Markup

Redline/
~—— Greenline Markup | <*— ..o

Layer

Blueline Markup
Point Features
®  Staging Point
&2 Fire_Truck
Line Features

e Street Closed <—— Feature
Layers

PR — Police_Line (Shapefile, geodatabase, SDE)

Polygon Features
Incident Area

m Hazardous Area

The Redline/Markup mode
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You are in Redline/Markup mode (shown above) as soon as you take your cap off the pen,
and the pen will stay in Redline/Markup mode until you make another selection from the
legend.

Feature Creation mode

As described in the section How to Open a Map and Select a Legend, you can also add
additional layers to your map, and these can be used with the pen and legend to add
features to your map. However, these function differently than the Redline/Markup options.
When using the additional legend items:

e You need to check the legend for each separate entry you make on the map
e Once you mark the map with the pen, Capturx returns to the Redline/Markup mode

For example, after you mark the location of the Staging Point on the map, the pen returns
to Redline/Markup mode so you can add notes or sketch next to the Staging Point feature
you just added. If you want to add additional Staging Points to the map, you need to check
the Staging Point symbol icon on the legend each time before you add the Staging Point
feature to the map.

Using the Pen and Map to Create Features
The following section summarizes the process for creating features on your map using the
two modes.

e By default, when you take the cap off the pen you are automatically in
Redline/Markup mode. The Redline/Markup legend consists of three colored lines you
can use to draw free hand lines, sketch, or add notes to the map. You can select a
line color at any time by checking the icon on the legend for the color markup you
wish to produce.

e You can select a different markup line color at any time and this selected line color
will now "stick", and all future markups will use that new color until another color is
selected.

e To create a GIS feature, touch the legend symbol for that feature. The next pen
stroke on the map page indicates where these features should be added on the map.

e Once the pen is lifted from the paper, the mode returns to Redline/Markup.

¢ You may select a different feature type by checking the appropriate symbol on the
legend at any time, after which the next stroke will create that feature.

Using the example given above, to add a Staging Point, you would check that icon in the
legend and mark the location on the map with a single dot of the pen. Then, when you lift
the pen off the paper, the mode returns to the Redline/Markup and you can make a note on
the map that a Staging Point is located here. You may want to write "SP" or draw a symbol
that reminds you of what you added.

You would switch to an another feature (Fire Truck) by checking that icon in the legend and
then touching the pen to the map to add the fire truck, and then write the acronym ‘FT’ next
to the location of the fire truck to remind you it was added to your map.
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Note: For the pen to recognize the legend symbol, you need to limit the size of your mark
to the size of the legend icon for that feature. Even a single "dot" by firmly tapping the pen
tip to the legend symbol will suffice. This will prevent your ink strokes from accidently
running into the adjacent feature symbol and "selecting" that feature for the map. Also note
that the digital pen does not work well at the edges of the map. Allow a 7 mm margin to
ensure that your ink strokes are captured correctly.

This section describes how to upload the ink using the docking station and Pen Manager for
Windows.

After you have made your markups and you are ready to upload your data, you need to
connect the docking station to your computer and insert the pen or you will need to use
Bluetooth to pair your pen to a mobile device. The following section takes you through that
process.

The docking station is used to dock your pen and to connect your pen to a PC or laptop via

the USB port. The docking station consists of the base, insert, and the USB port you use to
connect the docking station to your computer.
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To upload the digital ink using the Pen Manager for Windows:

[

Attach the docking station to a PC or laptop via the USB port.

2. Fully insert the pen in the docking station. The gold connection points on the pen and
docking station need to be aligned and the pen needs to be firmly placed in the
docking station.

3. After you connect the USB port to your computer and dock your pen, a semi-

transparent Status Window will also show you the progress of the download.

To upload the digital ink using Bluetooth with Capturx Mobile for BlackBerry:

1. Pair your digital pen with a supported mobile device
2. Open the configuration options on the Capturx Mobile application
3. Enter the email address where you want to send data
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4. Choose Direct Email as the upload method

5. After collecting data, tick the send data to phone
a. The pen will buzz twice telling you that the connection has been made
b. The pen will buzz three times after the data has been sent to the phone

For more information on Pen Manager for Capturx Mobile and its features, see the user
guide:

http://www.adapx.com/WebHelp/CapturxPenManagerForCapturx
Mobile/Help/1.0/Index.htm

See the Using the Pen Managers section for a description of how the Windows Pen Manager
is used to monitor and download the ink and to manage the features and options available
on your pen.

Reviewing the Changes You Have Made

After you have uploaded your changes, you can review them. The following section
describes how you review the changes you have made to your map. This includes:

e An overview of deleting and modifying features during the review session

e Using the Session Selection window to choose the particular session you want to
review

e A description of the reviewing options available with the Capturx toolbar and the
process for accepting or rejecting the features you have added.

Deleting and Modifying Features during the Review Session

When making changes to your geodatabase, ArcGIS Desktop only “edits” one data source at
a time. Unlike standard ArcMap editing, Capturx opens an edit session for all databases
(workspaces) at the same time and the active workspace will be determined by the *first’
layer you added data to with the digital pen.

When reviewing and editing Capturx features you need to be aware of which feature is in
the “target” list in the ArcMap editor toolbar. If the feature you are reviewing is under the
ArcMap"“target” feature layer you will be able to edit, delete and modify the geometry or
vertices of the features as you normally would. However, if the feature you are reviewing
belongs to a feature layer outside the ArcMap “target” layer, you can still edit the features,
but you are limited to editing them through their attribute table. Editing the geometry and
vertices of these features outside the “target” layer must be done outside the current
Capturx edit/review session.

Importing Your Review Session

After you have docked your pen and imported your sessions, you can use the buttons
highlighted below to select, accept or reject the changes you have made to your map. The
first toolbar shows you the options available in the layout view and the second shows you
the options available in the data view.
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To review changes on the map:

+

A. Select the Import Next Session button - on the Capturx toolbar to download
the next session available on the current map so that your changes will appear on
the map.

Or

Y

B. Select Open Session Dialog Box button on the Capturx toolbar and it will
show you a current list of sessions you have uploaded. This includes the:

¢ Name of the map

e User name associated with the pen and can be defined in the Pen Manager for
Windows

¢ Time and date the upload was received

1. Select the Import button to upload the desired session or double-click on the item.
The Import button is only enabled for sessions associated with the current map - to
load a session for another map, use the "Open Session Dialog Box" button. The
correct map will automatically open. If the target .mxd file cannot be found, you will
have the option to browse for it.

Capturx for ArcGIS Desktop E’

Select Session o Activate:

3900 AM

1A 372003 203 AM

=
Z| ®

2. The features you have made will be shown on the map.
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3. Use the Capturx toolbar to select all pending changes or to step through your
features one at a time. The feature you select will be highlighted on the map.
4. Use the Accept all button to accept all changes (reviewed or not) made to the

geodatabase. Use the Reject all button to reject all changes (reviewed or not) made
to the geodatabase.

Add Annotation Import Next Select All Select First Select Next Reject All
Layer Session Pending Change Change Changes

Voo T

OB WU YIRVIH OO
r..¢. 8. 391 &F "

Print Map and Open Session Clear All Select  Select Last Accept All
Legend Selection Pending Previous Change Changes
Window  Features Change

5. When you select the Reject All button the following window appear asking you to
cancel the rejection, remove the session you have just imported, or to revert the
session so you can re-import it again at a later time.
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Using the Pen and Docking Station

After you have made your markups and you are ready to upload your data, you need to
connect the docking station to your computer and insert the pen. The following section
takes you through that process.

The docking station is used to dock your pen and to connect your pen to a PC or laptop via
the USB port. The docking station consists of the base, insert, and the USB port you use to
connect the docking station to your computer.
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To upload the digital ink using the pen:

[

Attach the docking station to a PC or laptop via the USB port.
2. Fully insert the pen in the docking station. The gold connection points on the pen and

docking station need to be aligned and the pen needs to be firmly placed in the
docking station.

3. After you connect the USB port to your computer and dock your pen, a Status
Window will also show you the progress of the download.
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Troubleshooting and Maintenance

Below is a listing of common errors that can occur with the pen and Capturx ArcGIS and
recommendations on how to resolve each of the issues.

Missing Markup Layer in the Table of Contents When Importing the Ink

1. When you create a markup layer and name it other than the default “Capturx
Markup.shp” name, such as “John Doe Capturx Markup.shp”

2. The user removes the Capturx Markup layer “John Doe Capturx Markup.shp” from
the table of contents.

3. The user then attempts to import a new ink session.

4. Capturx will inform the user the markup layer can’t be found and ask the user to
create a new layer. The user then has the choice:

a. Create a new Capturx Markup Layer and choose where to save it
The user will be informed that all Markup ink will be defaulted to “Redline
Markup”, the other colors (green/blue markup) will turn into redline markup
b. Or the user can manually find the “John Doe Capturx Markup.shp” Capturx Markup
Layer by entering its location path and name into the window in step (a).

If the pen does not turn on when you take off the cap, make sure the pen is fully charged.
Insert the pen into the USB cradle to recharge the battery.

The pen does not charge when connected to the docking station.

1. Make sure the computer is turned on.

2. Make sure the docking station is connected to the computers USB port - verify that
the USB cable is tightly inserted into the dock bottom plug

3. Make sure the pen is fully seated

4. Try using another USB port on the computer.

Contacting Adapx Technical Support
You can also contact the Technical Support department directly by email or by phone:

e techsupport@adapx.com
e 866-208-9673

Care and Maintenance of the Pen

Your pen is a product of superior design and craftsmanship and should be treated with care.
The suggestions below will help you protect your warranty coverage.

1. Although the pen is designed to work on all-weather environments, try to keep the
device dry. Precipitation, humidity, and all types of liquids or moisture can contain
minerals that can corrode electronic circuits.
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2. Do not use or store the device in dusty, dirty areas. Its electronic components can be
damaged. Always keep the cap on when you are not using the pen.

3. If possible, try not to store the device in hot areas, as with any electronic
components and equipment. High temperatures can shorten the life of electronic
devices, damage batteries, and warp or melt certain plastics.

4. Do not store the device in freezing areas. When the device returns to its normal
temperature, moisture can form inside the device and damage electronic circuit
boards.

5. Do not drop, knock, or shake the device. Rough handling can break internal circuit
boards and fine mechanics.

6. Do not use harsh chemicals, cleaning solvents, or strong detergents to clean the
device.

7. All of the above suggestions apply equally to your battery, charger, or any
enhancement. If any device is not working properly, take it to the nearest authorized
service facility for service.

Changing the Ink Cartridge

You can change the ink cartridge by using the ink cartridge removal hole. This section takes
you through the removal steps. The ink is under pressure, so be careful when changing the
cartridge that you don’t break the tip.

To change the ink cartridge:
1. Remove the cap and place the ink cartridge in the hole provided on the shirt clip.
2. Gently pull to extract the cartridge.
3. Insert the new cartridge and press to fully seat.

For more information on the pen and docking station, see the following topics:

Charging and Using Your Pen
Using the Pen and Docking Station

1/07/10
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